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Aims and Learning Objectives 
These practical tips and guidelines for producing posters in PowerPoint will help you to: 

• plan and design a large, academic poster to present your research; 

• set up PowerPoint for A0 size; 

• use guides and text boxes; 

• insert and format text; 

• insert and modify image files; 

• add colours, borders and backgrounds; 

• use Group, Align and Distribute tools; 

• consider print options for large formats; 

• access further design tips and websites for poster competitions and poster design. 
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Document information 
Course documents and files 
If you are using this document in a training room in the Computer Centre, the practice files are 
stored in the folder C:\User\Powerpoint\Posters\.  
If you are using this document for self-study, the practice files associated with this document 
(document number pptxp-ss3) are from the following URL:  

www.bristol.ac.uk/is/learning/courses/studentcourses/resources-presenting.html 

You will see a link to Practice files.  This contains the files you need to work through the course 
notes.  In Internet Explorer you extract the files as follows: 

• Click on Practice files; 

• Choose Save. 

• Browse to where you want to save the file and click on Save (the practice files are grouped 
together, and you need to extract them to be able to use the individual files); 

• Go to the file you have just saved, and Open or Run it to show the Self-extracting Archive 
box; 

• Select where to extract (save) the files on your system using the browse button (as shown 
opposite); 

• Click Start to save the files. 

 

 

Related documentation 
Other related documents are available from the web at: 

www.bristol.ac.uk/is/learning/courses/studentcourses/resources-presenting.html 
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Introduction 
This document is an aid to producing academic posters for presentation at conferences, 
etc.  Although PowerPoint was not designed for producing posters, it can be set up to 
do so. 

There are different ways of achieving this.  The notes here simply offer guidance for 
approaching this, within the limitations of using PowerPoint for this task. 

A practice exercise also offers the chance to re-create a large, academic poster using 
text files and images provided.  These items have been extracted from a prize-winning 
poster produced by a UoB student. 

Prerequisites 
To follow this course, you must be able to manipulate images and text boxes, format 
text and use the commands on the Draw menu and on the drawing toolbar.  These 
skills can be acquired by attending one of the courses: Further PowerPoint (see Staff 
Development Course Diary) or Making more of PowerPoint (see the student Courses 
On-Line Booking System at www.bristol.ac.uk/studentskills). 
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Task 1 Posters in PowerPoint 
Objectives To create a large, academic poster in PowerPoint. 

Comments In these notes you will find: 

• tips and guidelines for creating your own poster (further details in Appendix A, 
Appendix C and Appendix D);  

• guidance for re-creating an existing A0 academic poster, using text and image 
files provided; 

• tables showing the layout and formatting used in the original poster (Appendix A 
and Appendix B). 

Alternatively you may use these materials as a basis for your own design and 
layout, as you wish. 

 

To re-create the poster using files provided for this task 
1.1 The aim of this exercise is to re-create the original poster (or design your own), 

incorporating the text and image files provided.  Refer to the following notes for tips 
and techniques in PowerPoint. 

• If using these notes in a Computer Centre Training Room, have a look at the A3 
laminated example of the poster.  The original PowerPoint file is also available at: 
C:\User\Powerpoint\Posters\poster_original.ppt. 

• The Word document text files used for this exercise are in the folder: 
C:\User\Powerpoint\Posters\ 
(eg text1_background.doc and caption6.doc). 

• The image files (which have been saved in various picture formats) are also in: 
C:\User\Powerpoint\Posters\ 
(eg chart1.bmp and chart8.jpg). 

• Appendix A and Appendix B contain tables showing which text files and 
formatting were used in the original poster, and the approximate layout. 

Note    If using these notes for self-study, see the Related Documentation section at the 
beginning of these notes for details of the location of these practice files. 

Before you start 
It is very important to set the poster size first.  Otherwise, if you work in A4 and later 
scale it up to A0, the print quality will be poor especially for any images included. 

If producing a poster for a competition, check the rules or requirements – especially 
the size – before you begin.  This exercise is based on A0 size, landscape. 

 

Starting PowerPoint XP and setting up for A0 size 
1.2 Go to:  Start / Programmes / Microsoft Office XP / PowerPoint. 

 From the New Presentation task pane, click Blank Presentation. 

 Choose the Blank slide layout (first left, under Content Layouts).   

Note    Avoid choosing a layout with Title or Text placeholders, as these are pre-formatted 
for larger font sizes than required for this task, and may cause formatting problems 
later.  If you have a Title and Text layout, click on the Blank slide layout in task pane. 
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 Go to File / Page setup. 

 From the Slides sized for list, choose Custom (see Figure 1): 

 
Figure 1 - page setup for A0 size 

 Type in the sizes required.  For exact A0 this will be: 
    Width: 118.9 cm (46”) 
    Height: 84.1 cm (33”) as shown above. 

 Orientation for Slides should automatically show Landscape. 

 Click OK, and save the file. 

Note    When creating your own poster, the size will depend on the printer you have 
available.  You will probably have to allow for a non-printable margin, and reduce 
your poster size a little, accordingly.   
Please check print size limitations before you begin. 
 
If working to a different size, the standard international paper sizes are: 
A0 – 118.9 x 84.1 cm  A2 – 59.4 x 42 cm 
A1 – 84.1 x 59.4 cm  A3 – 42 x 29.7 cm 

 

Using guides and ruler 
For a large, complex layout, it may help to use Guides (moveable dotted lines that 
appear on the screen but do not print) and to view the Ruler to help arrange them 
precisely: 

Viewing the ruler 
1.3 Choose View / Ruler to turn it on (or off, later). 

Viewing and adding guides 
 Choose View / Grid and Guides. 

 Tick the Guide settings to Display drawing guides on screen  
(Other guide options are explained more fully later and shown in Figure 3). 

 This gives one horizontal and one vertical guide.  To add another guide, hold down 
the <Ctrl> key and drag an existing guide across.  Repeat for more guides. 

 Add and drag guides across as appropriate for your design layout, to help line up 
text and images (see Figure 2). 
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 To align them, click on a guide to see its distance from the centre.  There is no quick 
way to space them evenly, but as you drag a guide, check its position on the ruler. 

 For this exercise, add guides (as shown in Figure 2) to create:  
a margin at each edge, 4 main columns and a title area at the top. 
For more accuracy, add extra (narrow) columns to leave space between text boxes: 

 
Figure 2 - setting up guides 

Deleting and hiding guides 
 To delete a guide, drag it off the slide. 

 To hide the guides without deleting them, return to View / Grid and Guides 
and un-tick Display drawing guides on screen. 

 

Creating text boxes 
Usually it is best to type straight into text boxes within PowerPoint, but text files are 
offered here to save you time.  You will need to open Word first, then copy and 
paste each piece of text into a PowerPoint text box: 

1.4 In PowerPoint: 

 Click the Text Box button on the Drawing toolbar (as shown opposite). 

 Click and drag across, to place a text box where required on the slide.  
It will expand when you add text. 

 

Adding text from a Word document 
1.5 For this exercise, keeping PowerPoint open, from the Start button open Word:  

Programmes / Microsoft Office XP / Word. 

 Open the relevant file from: C:\User\Powerpoint\Posters 

 For a guide as to which file relates to which text box in the poster, see Appendix A 
(or use randomly as you wish, just for practice). 
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 Select just the text required, without any extra space around it,  
(or delete any extra space first, then press <Ctrl> + <A> to Select All). 

 Copy it from Word  (shortcut: <Ctrl> + <C>) 

 Paste it into the PowerPoint text box (shortcut:  <Ctrl> + <V>). 

 To change Word wrap options, right-click in the text box and choose 
Format Text Box / Text Box tab. 

 

Formatting text 
1.6 For this exercise, for a guide as to which fonts and sizes are used in different 

sections of this poster, see Appendix B. 

 Select and format the text in the usual way. 

Note    For your own poster, try different fonts and sizes to see what fits best.  Some fonts 
take up more space than others, even for the same ‘font size’.  There are different 
design considerations too:  Generally, a sans-serif font such as Arial is clearer to 
read (especially from a distance) but Times New Roman will allow you to fit more 
text into the same space.  So it may be appropriate to use a sans-serif font, eg Arial, 
for headings and Times New Roman for the main text. 

 

Moving and aligning text boxes or images 
1.7 To move an object, click and drag it on the slide: 

Aligning objects to guides – or not 
 Drag the object near to a guide, and its edge or centre will snap to the guide. 

 To free you from this and allow finer control, press the <Alt> key as you drag the 
object. 

Moving and aligning objects with precision 
The grid is a set of lines, normally invisible, to which objects are attracted (by 
default). The spacing of the grid, and whether objects snap to it, is controlled by 
options in View / Grid and Guides. 
If you also wish objects to tend to line up with each other: 

1.8 Choose View / Grid and Guides. 

 Tick Snap objects to other objects. 

  

 
 

 

 

 

 

 

Default setting: 
The grid acts like a 
magnet, attracting 
objects which are 
moved close to it. 

Display grid or 
guides to help 
manual positioning 
of objects. 

Give objects grid 
lines that go through 
their vertical and 
horizontal edges. 
These exert a 
“magnetic” pull on 
other objects, 
helping to align 
them. 

Define space 
between lines of the 
grid, ie how fine it is. 
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Figure 3 - grid and guides 

Move and re-size objects 
1.9 Select and drag an object to move it.   

Remember to check that the mouse-pointer is right for the task (point to the middle 
of an object to move it, or on a ‘handle’ to re-size): 

                                       
           move                 re-size (width-ways)        re-size (height and width) from a corner 

 

 To constrain an object so that it moves only horizontally or vertically,  
press the <Shift> key as you drag it. 

 You can also nudge an object into place by selecting it and using arrow keys. 

 

Align, order and group objects 
1.10 To align any number of items (text boxes, images etc) on the slide: 

 Select all the items you wish to align  
(select one, and hold down the <Shift> key while selecting more objects together). 

 From the Draw menu (bottom left of screen) choose Align or Distribute (see Figure 
4). 

 Click the option you require  (eg Align Top for a row of objects). 

 Use the same menu to Distribute items in relation to each other, for example 
Distribute Horizontally. 

 

 
Figure 4 - Align or Distribute options 
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Note    To distribute objects evenly across the slide, you may need to first tick Relative to 
Slide (bottom of menu - see Figure 4) then go in again to choose Distribute 
Horizontally.  (However if this is ticked when you choose Align Top, objects will go to 
top of slide!) 
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Ordering and grouping objects 
1.11 To arrange objects such as text boxes and images in your poster, some further 

commands in the Draw menu (bottom left of screen) can be useful, eg: 

Order 
If you need to add one item on top of another, eg a logo onto a coloured box, 
remember you can use Order options from the Draw menu to bring the selected 
object forward, or send the selected background shape to the back. 

Group 
To help with your layout, you can group together any combination of images and 
text boxes that you want to keep together.  For example: 

 Select two or more text boxes. 

 From the Draw menu click Group. 

 You can now drag, move or re-size this group as one item. 

Remember, if you wish to modify any of these components later you will need to 
Ungroup them again first.  (Select the group then click on Draw / Ungroup). 

 

To add a line around a group of objects 
1.12 A simple way to add a line around a group of objects, is to add a rectangle and then 

remove its fill colour, to leave just the line: 

 Click the rectangle tool (drawing toolbar) then click and drag a rectangle shape 
approximately where needed on the slide. 

 With it still selected, click the drop-down arrow next to the Fill Color icon and 
choose No Fill: 

 
Figure 5 – removing Fill Color from a shape 

 You can resize the rectangle as needed and modify the line using the Line Color 
and Line Style icons (drawing toolbar). 
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Colours and borders 
1.13 Well-chosen colours can be used to great effect to enhance your poster.   

Use bolder colours for areas you wish to emphasise (such as main headings) and 
softer colours for subheadings, for example.   
Try to keep good contrast between text and background colour. 

Text box colours and borders 
 Select the main heading text box. 

 Go to Format / Text Box. 

 Choose Fill Color, Line Color and Line Weight as you wish. 

 To apply the same colours to a number of text boxes, you can select them together 
by holding down the <Shift> key, then apply formatting as above. 

 

Poster background 
1.14 Try different background colours for your poster, to find one that complements the 

main content without distracting from it.   

To apply a plain background colour: 
 Go to Format / Background and click the dropdown arrow within it (see Figure 6). 

 Try More colors or Fill Effects for further options. 

 
Figure 6 - background options 

To apply a picture as a background:  
While a plain background colour is probably safer and often recommended, some-
times a picture related to the topic can work well, providing it does not distract from 
or obscure the text.  The picture must be prepared and saved as an image file first. 

 Go to Format / Background and click the dropdown arrow: 

 Click on Fill Effects, then the Pictures tab. 

 Click the Select Picture button to browse for your image file (previously prepared 
and saved). 
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 Click Insert, OK and Apply. 

Inserting images and charts 
 

Inserting images from file 
1.15 To insert a previously-saved image, go to: Insert / Picture / From file. 

 Browse to the saved picture file.  Charts and logos for this exercise can be found in: 
C:\User\Powerpoint\Posters 

 Click insert.  Once inserted, select the image, move and re-size it as required. 

Adding logos 
The logos used for this exercise are: 

• UOB logo, already saved in:  C:\User\Powerpoint\Posters\ logo-screen.gif. 

• British Heart Foundation logo, saved as:  bhf_logo.gif. 
1.16 If you wish to give the UOB logo a transparent background: 

 Insert the image (from file) into PowerPoint. 

 Select the image, and click Set Transparent Color button on the Picture toolbar: 

 
Figure 7 - set transparent color 

 Click on the white background area of the logo with this tool. 

Using images for your own poster 
For a large poster, images need to be of good quality and high resolution to work 
well.  A small picture stretched out is likely to pixilate and lose clarity.  Prepare your 
images beforehand and check to see how they would print at the required size.   
It is advisable to save them into one folder, ready to insert. 

1.17 For University of Bristol logos, and guidelines on how they may be used, see: 
www.bristol.ac.uk/cms/pro/visualidentity/. 

Where to print A0 size posters 
To print your poster full size, you need to find a large enough printer to handle this. 

The University’s Print Services can offer printing and laminating up to A0 size:  

www.bristol.ac.uk/printservices/poster.html 

Alternatively, try contacting the School of Geographical Sciences (geog-
office@bristol.ac.uk) who can print up to A0 size for a charge.     

The Department of Pharmacology owns a large format printer (A0 size) capable of 
printing posters for conferences/meetings etc.  It was originally bought for internal 
use but other departments and faculties may use it on a paying basis. Contact the 
department for information. 

Otherwise, you can try local commercial printing and publishing companies.  
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Appendix A Guide to text and images used in poster 
Files are stored at: C:\User\Powerpoint\Posters\ in the training room. 

UOB logo main_heading.doc Heart logo 

2         caption2.doc 4         caption4.doc 6         caption6.doc 

text1_background.doc 
Chart2 Chart6 Chart9 

text2_aim.doc caption2.doc caption4.doc caption6.doc 

3         caption3.doc caption4.doc caption6.doc 

Chart3 Chart7 Chart10 text3_methods.doc 

caption3.doc caption4.doc caption6.doc 

1         caption1.doc chart4 + caption3 5         caption5.doc text4_summary.doc 

Chart1 caption3.doc Chart8 text5_acknowledge.doc 

caption1.doc chart5 + caption3 caption5.doc text6_refs.doc 
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Appendix B Guide to text and text box formatting used in poster 
 

UOB logo 

Main heading – Dotum (or Arial) 90       deep yellow background (bg) 

 

Sub-heading – Times 66 

Heart logo 

2    Arial 36   mid-yellow bg 4    Arial 36   mid-yellow bg 6    Arial 36   mid-yellow bg 
Heading – Arial 40 pt 

Text – Times 24 pt Chart2 Chart6 Chart9 

Text – Times 24 Text – Times 24 Text – Times 24 Text – Times 24 

3    Arial 36   mid-yellow bg Arial 30   light yellow bg Arial 30   light yellow bg 

Chart3 Chart7 Chart10 

 

Text – Times 24 

 

[Numbers – Arial 54 bold] 
Text – Times 24 Text – Times 24 Text – Times 24 

1    Arial 36   mid-yellow bg chart+ Arial 30 light yellow bg 5    Arial 36   mid-yellow bg Text – Times 24 pt 

Chart1 Arial 30   light yellow bg Chart8 
Heading – Arial 40 

Text – Times 24 

Text – Times 24 chart+ Arial 30 light yellow bg Text – Times 24 
Heading – Arial 40 

Text – Arial 20 
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Appendix C Further tips and guidelines for creating 
your own poster 

 
Planning the content 
Plan your poster before you begin.  Think about the main topic and message you wish to 
convey, and plan the sequence rather like a storyboard.  Some design tips are also included 
in  Appendix D. 

Preparing image files 
Decide which images and charts you wish to include and prepare any image files first. 

For complex charts and image files, you may need to go through several stages to arrive at 
a file-type that PowerPoint can accept. 

For example, data captured from scientific instruments may need to be manipulated in 
several programmes, including image processors to render them in a suitable form.  
Ultimately, they need to be saved in a file format that PowerPoint can accept.  The 
programmes Spike, Catch and Adobe Illustrator were among those used to create these 
examples.  We cannot advise on these other programmes, but research students may find a 
supervisor or tutor in their department who is familiar with these processes. 

File types that are acceptable to PowerPoint include: 

• Enhanced Metafile (.emf); 

• Graphics Interchange Format (.gif); 

• Joint Photographic Experts Group (.jpg); 

• Portable Network Graphics (.png); 

• Windows Bitmap (.bmp, .rle, .dib); 

• Windows Metafile (.wmf) graphics.  

 

Additional file types can be used, providing a filter was installed with PowerPoint.  For more 
information see the Help menu in PowerPoint. 

Adding text directly 
It is recommended to type directly into the text boxes in a large poster, because: 

• text imported from elsewhere is likely to need re-sizing and reformatting within 
PowerPoint; 

• typing directly into the poster helps you to be aware of how much (or how little!) space 
you have, and to write more concisely as appropriate. 

 
Useful websites 
Further excellent tips on How to Make a Poster may be found at: 

www.bio.cam.ac.uk/gradschool/current/courses/postertalk1.htm. 

 

The following website shows examples of a Poster Competition and winning posters: 
www.grad.ucl.ac.uk/comp/2004/poster/. 
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Appendix D More guidelines for posters  
Used for a Joint Inter-University poster competition.   
Reproduced with permission from University College, London Graduate School. 
 

Your poster should be designed to convey the essence of your research in a clear and eye-
catching way, to appeal to colleagues as well as non-specialists. 

  

The ideal poster will:  

• attract passers-by to stop and take an interest;  

• make a good impression;  

• enable the viewer to remember key details of your research (what, why, how, who?);  

• encourage viewers to contact you for more information about your research.  

 

Poster size 
You will have approximately 1 metre (height) by 2 metres (width) of space on which to display your 
poster. 

  

Viewing distance 
 You should ensure that your poster can be read clearly from a distance of 1 metre or more. 

  

Viewing time  
It should be possible for the viewer to absorb the general information in your poster in a short time 
(up to 3 minutes). 

 
General tips on how to present your poster  
Title Should be meaningful but not complicated. Try not to baffle the readers 

(especially the non-specialists). 
Clarity Your display should be visually clear and easy to follow, with a clear 

description of the aims and method. 
Colour Good use of colour is helpful. Even if the majority of the material is in black 

and white it is important to highlight with colour. However, bear in mind 
that too much colour can be visually confusing. 

Message  Ensure that the general overview of the poster is clear, and that the more 
detailed information is not too complex. 

Relevance Demonstrate how your research fits in with the world as a whole, to help 
viewers relate to it. 

Images Make sure the images you use are clear and of good quality. 
Graphics These must be sharp and relevant to the presentation. Charts, drawings 

and illustrations should be simpler and more heavily drawn than those you 
would use for slides. Use of colour is encouraged to add emphasis 
effectively. 

Font-style and Be consistent in your choice of font, limiting yourself to one or two. Ensure 
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size that the font sizes are legible from the indicated viewing distance. 
Grouping Text and graphics should be grouped together in relevant and visually 

stimulating sets. 
Layout/flow Guide the viewer's eye in an orderly way. Ensure that there is a logical 

path of items to be followed. It may be appropriate to link sections with 
lines or arrows. 

Borders Adding an outer border to your poster, and bordering any sections 
contained within, generally helps to define your display clearly. 

Contributors Identify any contributors other than those shown at the top of your display. 
Contact point Provide your contact details to encourage people to find out more about 

your research. This could involve adding leaflets or cards for readers to 
take with them. 

Summary A concise summary may be useful. This could be done by giving a set of 
key points. 

  

  

Try to Avoid: 
Window pane 
effect  

Straight rows and columns of information are not visually stimulating 
especially if the size and content of each appears similar, giving a 
window-pane effect. Use a pattern of sections - this need not be regular. 

Sparseness Make sure that enough information is included on the poster. Don't make 
up for lack of information by using exceptionally large fonts and figures. 

Clutter Conversely, avoid having so much information that the sections 
presented are unable to stand apart. 

Too much detail Don't be tempted to include all you know on the subject - remember that 
the viewer has a limited time to look at your poster. 

Irrelevant detail Try to avoid inappropriate side issues that may detract from the main 
subject. 

 

 


